The Structural Engineering Services Platform for Innovation and Development

Beam Detailing V1.1 User Manual
For
SAP 2000 –ETABS – RISA 3D

August 2015
Barcelona -Spain
Copyright

Copyright © SESPID, S.L. 2015
All rights reserved.

The program Beam Detailing®, and all associated documentation are proprietary and copyrighted products. Ownership rests with the Structural Engineering Services Platform for innovation and Development SESPID, S.L. Unlicensed use of this program or reproduction of documentation in any form, without prior written authorization from SESPID, S.L., is explicitly prohibited.

No part of this publication may be reproduced or distributed in any form or by any means, without the prior explicit written permission of the publisher.

Further information info@sespid.com
Further support support@sespid.com
DISCLAIMER

Content:

List of Figures ............................................................................................................................... v
1 Introduction .......................................................................................................................... 6
2 Release Notes and New Features.......................................................................................... 7
3 Beam Detailing Package for ETABS and SAP 2000 ........................................................... 8
   3.1.1 Export date from ETABS ...................................................................................... 8
   3.1.2 Export date from SAP 2000 ................................................................................ 12
   3.1.3 Read ETABS /SAP 2000 outputs and generate the input for Beam Detailer:...... 15
3.2 Beam Detailer for ETABS and SAP 2000 ................................................................. 17
   3.2.1 Plan Generator Application ................................................................................. 19
   3.2.2 Beam Detailing Application ................................................................................ 21
   3.2.3 Arrangement of steel bars ................................................................................... 25
   3.2.4 Materials Memory ............................................................................................... 29
   3.2.5 Beam Framework and Reinforcing Bar Hook:.................................................... 29
   3.2.6 Plan Beam Detailing Application:....................................................................... 29
3.3 Tips................................................................................................................................... 31
### List of Figures

<table>
<thead>
<tr>
<th>Figure</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>New Features of Beam Detailing V1.1</td>
<td>8</td>
</tr>
<tr>
<td>2.</td>
<td>Assign minimum number of station locations [ETABS]</td>
<td>9</td>
</tr>
<tr>
<td>3.</td>
<td>Adjust the end length offsets [ETABS]</td>
<td>9</td>
</tr>
<tr>
<td>4.</td>
<td>Define new table set [ETABS]</td>
<td>10</td>
</tr>
<tr>
<td>5.</td>
<td>Selected tables in the table set [ETABS]</td>
<td>10</td>
</tr>
<tr>
<td>6.</td>
<td>Selected floor in interest to export the tables [ETABS]</td>
<td>11</td>
</tr>
<tr>
<td>7.</td>
<td>Change the units of the table set [ETABS]</td>
<td>11</td>
</tr>
<tr>
<td>8.</td>
<td>Export the XML file [ETABS]</td>
<td>12</td>
</tr>
<tr>
<td>9.</td>
<td>Save the XML file [ETABS]</td>
<td>12</td>
</tr>
<tr>
<td>10.</td>
<td>Selected floor in interest to export the tables [SAP 2000]</td>
<td>13</td>
</tr>
<tr>
<td>11.</td>
<td>Change the units to mm [SAP 2000]</td>
<td>13</td>
</tr>
<tr>
<td>12.</td>
<td>Selected tables [SAP 2000]</td>
<td>14</td>
</tr>
<tr>
<td>13.</td>
<td>Display all the tables [SAP 2000]</td>
<td>15</td>
</tr>
<tr>
<td>14.</td>
<td>Save the tables in txt format [SAP 2000]</td>
<td>15</td>
</tr>
<tr>
<td>15.</td>
<td>BeamDetailing shortcut</td>
<td>16</td>
</tr>
<tr>
<td>16.</td>
<td>Beam Detailing Generator user interface</td>
<td>16</td>
</tr>
<tr>
<td>17.</td>
<td>Reading the XML file and generating input files [ETABS]</td>
<td>16</td>
</tr>
<tr>
<td>18.</td>
<td>Reading the TEXT file and generating input files [SAP 2000]</td>
<td>17</td>
</tr>
<tr>
<td>19.</td>
<td>Load Beam Detailer for ETABS and SAP in AutoCAD</td>
<td>18</td>
</tr>
<tr>
<td>20.</td>
<td>Beam Detailer user interface</td>
<td>19</td>
</tr>
<tr>
<td>21.</td>
<td>Launching Plan Generator</td>
<td>19</td>
</tr>
<tr>
<td>22.</td>
<td>Generated Plan Layout [ETABS]</td>
<td>20</td>
</tr>
<tr>
<td>23.</td>
<td>Unique name of beam element in ETABS model</td>
<td>20</td>
</tr>
<tr>
<td>24.</td>
<td>Beam Detailer user interface</td>
<td>21</td>
</tr>
<tr>
<td>25.</td>
<td>Options to control the basic reinforcement</td>
<td>22</td>
</tr>
<tr>
<td>26.</td>
<td>Transverse reinforcement options ETABS</td>
<td>22</td>
</tr>
<tr>
<td>27.</td>
<td>Transverse reinforcement conditions and requirement ACI 318</td>
<td>23</td>
</tr>
<tr>
<td>28.</td>
<td>Maximum space between bars at the cross section</td>
<td>23</td>
</tr>
<tr>
<td>29.</td>
<td>Launching beam detailing application</td>
<td>24</td>
</tr>
<tr>
<td>30.</td>
<td>Adjusting the beam spans lengths</td>
<td>25</td>
</tr>
<tr>
<td>31.</td>
<td>Fixing the spans lengths</td>
<td>25</td>
</tr>
<tr>
<td>32.</td>
<td>Adjusting the supports widths</td>
<td>25</td>
</tr>
<tr>
<td>33.</td>
<td>Start the detailing for a singular beam</td>
<td>25</td>
</tr>
<tr>
<td>34.</td>
<td>Longitudinal bars arrangement</td>
<td>26</td>
</tr>
<tr>
<td>35.</td>
<td>Extension rules for longitudinal bars ACI 318</td>
<td>27</td>
</tr>
<tr>
<td>36.</td>
<td>Extension of the additional top boars</td>
<td>27</td>
</tr>
<tr>
<td>37.</td>
<td>Extension of the additional bottom boars</td>
<td>28</td>
</tr>
<tr>
<td>38.</td>
<td>Case of shear wall edge support</td>
<td>28</td>
</tr>
<tr>
<td>39.</td>
<td>Envelopes diagrams and station locations</td>
<td>28</td>
</tr>
<tr>
<td>40.</td>
<td>Materials short memory</td>
<td>29</td>
</tr>
<tr>
<td>41.</td>
<td>Launching the Plan Beam Detailing Application</td>
<td>30</td>
</tr>
</tbody>
</table>
1 Introduction

Beam detailing Package is a product of the The Structural Engineering Services Platform for Innovation and Development SESPID. Beam Detailing package is compatible with different structural analysis software such as (ETABS 2013.2.2 or any higher version, SAP 2000 V16 or an higher version, RISA 3D V11 or any higher version). The package consists of two main software:

**Beam Detailing Generator (BDG):** An executable software works in Windows environment. Responsible on reading the outputs of the structural analysis software, analyzing filtering and then generating different files, these files will be used later by the second software **Beam Detailer.**

**Beam Detailer (BD):** Responsible on reading the outputs of **Beam Detailing Generator** directly in ACAD environment (AutoCAD 2010 or higher version). Then performing the beams detailing layouts for a single beam or for the entire selected floor.

In the case of ETABS and SAP 2000 models, Beam Detailing reads the design results (already done via ETABS or SAP 2000), by the application BDG. All the beams to be detailed must be checked and designed via ETABS or SAP 2000 without any warning message. The detailing afterwards for each beam or for the entire selected floor can be done in AutoCAD by using the software BD.

In the case of RISA 3D model, Beam Detailing package is also able to design the beams in interest based on the extracted forces from RISA model. The design can be done via BDG.
2 Release Notes and New Features

This chapter demonstrates the new features that have been added to the previous release of Beam Detailing Package (V1.1).

New feature:

1. The U.S bars designations (#) has been added to previous metric designations. The user can chose between Metric and designations to represent the bars diameter (number) for each layout as shown in Figure 1. This option is valid for longitudinal and transverse bars. Like example /#8-d25/ if the user chooses Metric designations the software will use d25 to identify the diameter and #8 if the user chooses the U.S designations.

2. A maximum bars length: This option gives the ability to the user to define the maximum bar length as shown in Figure 1. This option will effect only the calculated bars weight, if any bar exceed this length, the software will assume that a bar splice (1.3 time the development length) is applied for this bar.

3. A favorite transverse bars spaces: The plotted spaces will be controlled by this list Figure 1. In other words the software will use always this list to approximate the calculated values to be the nearest one in the list. This favorite list can be changed by the user (a space between each two values is required always, values must be always in cm). If the required space in any station location, is less than the minimum values in the favorite list. The software will uses the required space to represent the traverse reinforcement at the same station location.

4. Extensions distances of the top and bottom bars are rounded off to 5 cm.

💡 For users who have the Beam Detailing V1.1 already installed on the computer, just need to replace the following files with the ones of version V1.1.

- BD-V1.1-ES-English AutoCAD.LSP.fas
- BD-V1.1-ES-Spanish AutoCAD.LSP.fas
- BD-V1.1-ES.DCL
Beam Detailing Package for ETABS and SAP 2000

Beam Detailing package is compatible with any version of ETABS that can export the design result in XML format and in (mm) units (ETABS 2013.2.2 or higher). For SAP 2000 models, Beam Detailing package is compatible with any version that can export several tables in one text file.

The following steps show the procedure must be followed to generate the detailing layouts for any ETABS or SAP 2000 model:

3.1.1 Export date from ETABS

1. Before running the analysis and performing the design, the user must be sure to do two steps first:
   a) Assign minimum number of outputs stations equal to 11,

   By selecting the beams > Assign > Frame > Outputs stations > Min number stations 11
Figure 2. Assign minimum number of station locations [ETABS].

b) Adjust the beam ends length offsets by taking into account the width of the columns (the supports)

By selecting the beams > Assign > Frame > End length offsets

Figure 3. Adjust the end length offsets [ETABS].

Automatic from connectivity or Define length option must be selected in such way to guaranty that the first outputs station will be at the face of the column (at End I), and the final outputs station will be at the face of the second column (at end J). Or any suitable end length offsets.

2. The model (the elements to be detailed) must be designed via ETABS without any warning message. Frame type must be selected first (ACI: OMRF-IMRF-SMRF) for more information you can refer to ACI-318-14. Any implemented design code in ETABS or SAP 2000 can be used to perform the design of the beams.

3. Define a new table set:

Options > Show Modal Explorer > in the Model Explorer go to tables > add new table set
Figure 4. Define new table set [ETABS].

The following tables must be selected in each of the following fields:

- **Structural Layout**:
  - Joint coordinate >
    - Joint coordinates
  - Frame connectivity
    - Column connectivity
    - Beam connectivity
    - Brace connectivity
  - Shell connectivity
    - Wall connectivity

- **Definitions**:
  - Frame sections
    - Frame sections
  - Shell sections
    - Shell sections – Walls

- **Assignments**:
  - Frame Assignments
    - Frame assignments - Sections
    - Frame assignments – Local Axes
  - Shell Assignments
    - Shell assignments – Sections

- **Design**:
  - Concrete Design
    - Concrete Beam Summary –ACI 318 -14

Figure 5. Selected tables in the table set [ETABS].

**Note**: In the case where some tables are not available to select, such as (Brace connectivity, Shell sections – Walls, Frame assignments – Local Axes, Shell assignments – Sections). This means that
the models doesn’t have brace or wall elements ,or the local axes are not modified for any element in the whole model. In this case the user can continue without any problem.

4. Select the floor in interest, the selection must include the nodes of the beams as well as all the supports (columns or shear walls) including the top and bottom nodes. Any non-structural elements in the model must be deselected as well as any steel beams before the exporting.

5. Modify the table set option > Units (mm)

6. Export the table sets to XML

   The export must be only for the selected floor.
3.1.2 Export data from SAP 2000

1. Before running the analysis and starting the design of the model, step 1 in ETABS chapter must be done also for any SAP 2000 model:
   
   a) Assign minimum number of outputs stations equal to 11,
   
   b) Adjust the beam ends length offsets by taking into account the width of the columns (the supports).

2. The model must be designed via SAP 2000 without any warning message. Frame type must be selected first (ACI: OMRF-IMRF-SMRF) for more information you can refer to ACI-318-11 chapter 21. Any implemented design code in ETABS or SAP 2000 can be used to perform the design of the beams.

3. Select the elements (The floor) in interest and make sure you have selected the top and the bottom joints of the supports (columns and shear walls), as shown in Figure 10.
Note: All the slab elements (horizontal shell elements) must be deselected before continue to the next step. This deselection is very important and especially in the case when SAP model has already a wall elements. This step must should be done for all SAP models but not for ETABS models.

4. Change the units to (mm) by scrolling the unit bar at the bottom right corner.

5. Keep on selecting the elements > Display > Show Tables >
The following tables must be selected:

➢ **Modeling definition:**

❖ Prosperity Definition :
  - Frame Section Prosperities >
    ✓ Frame Section Prosperities01-General
  - Area Section Prosperities >
    ✓ Frame Section Prosperities.

❖ Connectivity Data :
  - Joint Coordinate
    ✓ Joint Coordinates.
  - Object Connectivity
    ✓ Connectivity Frame
    ✓ Connectivity Area
Frame Assignments:
- Frame Item Assignments
  - Frame Sections Assignments
  - Frame Local Axes Assignments

Area Assignments:
- Area Item Assignments
  - Area Sections Assignments

Design Data:

Concrete Frame:
- Concrete Summary Data
  - Concrete Design 2- Beam Summary Data –ACI 318-11

Figure 12. Selected tables [SAP 2000].

Note: If there are some unavailable tables to select in the Tables window, the user can continue to the next step without any problems.

6. Press Ok, Then go to File > Display All Tables > In Text Editor W/No Splits as shown in Figure 13. All the selected tables will be plotted in just one file, this file will be used later to carry out the beam detailing layouts.
7. Save the text file in a selected file:

Figure 14. Save the tables in txt format [SAP 2000].

3.1.3 Read ETABS /SAP 2000 outputs and generate the input for Beam Detailer:

Run Beam Detailing Generator:
In this chapter we will explain how to read the ETABS xml file, generating the input file for Beam Detailer Software. By clicking on the shortcut of BeamDetailing.exe the user interface in Figure 16 will appear.

Figure 15. BeamDetailing shortcut.

A. Click on ETABS to work on ETABS generator
B. Select a Path to save the output of BDG (The Project Directory)
C. Select the XML file that has been exported previously.
D. Click on Generate

Figure 16. Beam Detailing Generator user interface.

Figure 17. Reading the XML file and generating input files [ETABS].

When you receive the message “Done” it means the files have been generated properly.

Generated files are:
Beam Detailing Package for ETABS and SAP 2000

- Different text files with different numbers (beam 01.txt, beam 02.txt ...etc.), each of these files corresponds to one of the detected beams in the selected floor. BDG detects the beams with tolerance angle equal to (15 degree). This means: any elements that have less than the tolerance angle will be collected as they are elements (Micro beams) in the mega beam (The one will be detailed later (beam 01.txt, beam 02.txt ...etc.).

- Plan_Generator.out: This files includes the geometry of the selected floor.

- Plan_Beam_Detailing.out: This file includes the design reinforcement for all the detected beams in the selected floor. In other words, this file include all the singles beams files in one file (Plan_Beam_Detailing includes beam 01.txt, beam 02.txt ...etc.)

Same procedure to read the XML of ETABS model can be done to read the exported text file from SAP 2000 model, as shown in Figure 18. By clicking on Generate button Beam Detailing Generator will generate the same files.

![Beam Detailing Generator](image)

Figure 18. Reading the TEXT file and generating input files [SAP 2000].

Note: If the SAP 2000 output file has (,) instead of (.) all the (,) must be replaced by (.) before running the Beam Detailing Generator software.

3.2 Beam Detailer for ETABS and SAP 2000

Beam Detailer software works in AutoCAD environment and contains of three applications:

**Plan Generator**: Reads the output Plan_Generator.out, and can be used only to draw the plan layout of the selected floor in ETABS model.

**Beam Detailing**: Reads any output of any single beam (beam 1, beam 2 etc.), and can be used only to perform the detailing for a single beam.

**Plan Beam Detailing**: Reads the output Plan_Beam_Detailing.out, and can be used only to perform the detailing for all the beams in the entire floor.
Each of the previous applications must be used to read the corresponding files or files, otherwise the application will not be able to run.

This chapter will use the generated files form ETABS model, same explanation can be applied on the generated files from SAP 2000 model.

Beam Detailer for ETABS and SAP 2000 software must be loaded every session the user wants to use it in each AutoCAD files by following the next steps:

In the AutoCAD menu bar go to > Tools > Auto Lisp > Load Application >

Figure 19. Load Beam Detailer for ETABS and SAP in AutoCAD.

BD V1.1-ES.fas files must be selected > load > you should receive a message “BD V1.1-ES.fas successfully loaded “

BD V1.1-ES.fas file can be saved in any location in the computer.

Please refer to the User Installation Manual to know more about BD V1.1-ES.fas file.

For English Version of AutoCAD you have to use the English version of BD V1.1-ES.fas. For Spanish Version of AutoCAD you have to use the Spanish version of BD V1.1-ES.fas

After receiving the message > write CSIBEAM in the AutoCAD command line>press Enter.

After pressing Enter, the next user interface will be appeared.
Field 1, is to choose on which application you want to work,

3.2.1 Plan Generator Application

By selecting Plan Generator in the field 1, Plan generator application will be active. All the other parts (Fields) will be disable, except field 6.
The path of where the outputs of Beam Detailing Generator (BDG) are located, must be selected and pasted in the path field. Text file name must be (Plan_Generator) without the extension .out, as we mentioned before this output works only with the application Plan Generator. Then press OK button.

The application will start immediately to draw the geometry of the selected floor (elements) by giving a new layer to each detected beam, each layer has different color and different name, similar to the same name of the detected beam as shown Figure 22.

*To see the plan you might need to use the AutoCAD zoom extend command*

![Figure 22. Generated Plan Layout [ETABS].](image)

Names of the detected beams corresponds to the names of the different beams files that have been generated by Beam Detailing Generator, in the Figure 22 like example:

In the element 12-1381, the first number is the number of the text file (beam 12.txt) it means this element is a part of the mega beam 12. The second number 1381 corresponds to the unique name of the beam element in ETABS model as shown in Figure 23. [In the case of SAP 2000 model the second number is the element’s label]:

![Figure 23. Unique name of beam element in ETABS model.](image)
The generated plan helps the user to understand the generated text files, moreover will help the user to understand the direction of each beam when it will be detailed by plotting the unique names at each span. In Figure 23 the beams with unique names (1396-1401-1386) have been detected as they are three different beams (6 - 8 – 2) respectively. BDG detects the shear wall elements and assumes that the beams before and after the shear wall elements are not continued as one beam [There are no common nodes].

3.2.2 Beam Detailing Application

By writing CSIBEAM again in the command line, the user interface will appear again.

Field 2: Longitudinal reinforcement:

- Basic top and bot bars: Are the constant reinforcement bars along the beam length at the top and the bottom of the beam.
- Skin steel bars: Are the middle bars along the length of the beam.
- Preferred top and bottom bars diameter: Are the diameters of the bars that will be used as an additional reinforcement to the basic reinforcement at the top and the bottom of the beam when it’s required.
- Preferred extra bars diameter: Is the diameter of the bar that will be used to fix the real number of required bars by using less diameter (less than the preferred top and bottom) to recover the difference between the real and the integer number when the decimal part of the required number is less or equal to 0.5, otherwise the program will use an integer number of bars.
- Maximum Basic reinforcement ratio: Is the maximum ratio of the basic reinforcement to the required reinforcement, the user wants to not exceed. Like example if the top reinforcement exceed this ratio the program will automatically decrease the basic top reinforcement by either:
  - Decreasing the number of basic top bars if the option (Nu of Bars) is selected.
  - Decreasing the diameter of the basic top bars if the option (Diameter) is selected.
The same algorithm will be applied on the basic bottom reinforcement.

If the option (Do not change) is selected, then the program will remain on the basic reinforcement (Top and Bottom)

The ratio of the basic reinforcement to the required reinforcement is calculated by dividing the basic reinforcement as it’s used for all the sections (station location) along the beam to the summation of the required reinforcement for the same sections.

Field 3 is to draw the envelope of the required reinforcement (The design reinforcement of ETABS) as well as the envelope of the additional reinforcement that must be added after using a constant reinforcement along the length of the beam (Basic reinforcement).

There are two scale factors:

- The scale factor for the longitudinal bars: The output of the longitudinal reinforcement of ETABS and SAP 2000 is (mm²), the program automatically change these units to cm² to fit with the layout of the beams (in meter). A scale factor equal to (0.01) means: each measured value on the envelope diagram later will be (0.01 x cm²).

- The scale factor of the transverse reinforcement diagram: The output of the transverse reinforcement of ETABS and SAP 2000 is (mm²/mm), the program automatically change these units to cm²/cm to fit with the layout of the beams (in meter). For scale factor equal to (1) it means each measured value in the transverse reinforcement diagram is (cm²/cm). For scale factor equal to (10) the measured value will be (mm²/mm).

Field 4: Transverse reinforcement

Frame type must be selected as one of the following reinforced concrete frame type (ACI 318-11):

OMRF: Ordinary Moment Resisting Frame
IMRF: Intermediate Moment Resisting Frame
SMRF: Special Moment Resisting Frame

Beam Detailer applies the transverse reinforcement requirements of ACI 318, based on the selected frame type. Figure shows the different between the three types of frames:
The stirrup bar diameter is in the previous figures is the Min stirrups bar diameter. Smallest longitudinal bar is always the smallest between the four diameters (top basic, top preferred, bottom basic, bottom preferred).

**Note:** *If the design had conducted via different standard, the user has to satisfy the transverse reinforcement requirement of this standard manually.*

Beam detailer calculates the number of transverse bars with the most appropriate bar diameter in the range between the minimum and maximum stirrups bars. The number of transverse bars is restricted with minimum value according to the maximum space between bars at the cross section, as shown in the Figure 28. Based on this input value the software will calculate the minimum number of transverse bars by giving a concrete cover equal to 2.5 cm from each side.
Beam detailer automatically increase the number of basic bars to match with the minimum number of transverse bars.

**Minimum clear span length to generate five transverse reinforcement zones:**
According to the input value the software will use five zones to place the transverse reinforcement when the clear span of any micro beam is more than this value.

**Clear span length to generate one transverse reinforcement zone:**
For any span that it’s less or equal of this value, the software will use a constant number of bars with constant space along the length of this span, based on the maximum required transverse reinforcement for all the station locations along this span.

For any case between the previous two cases, the software will generate three transverse reinforcement zones.

**Field 5: Material Properties:**
The user must input the concrete strength of the beam as well as the steel strength of the longitudinal bars. These values will be used to calculate the development length of the bars by using the next formulation in the ACI 318M [12.2.2] assuming one of the next conditions is satisfied:

\[
\begin{align*}
\text{Spanding and cover} & \\
\text{Clear spacing of bars or wires being developed or spliced not less than } d_0, \text{ clear cover not less than } d_0, \text{ sharts and lures throughout } c_t \text{ not less than the Code minimum} & \\
\text{Clear spacing of bars or wires being developed or spliced not less than } 2 d_0 \text{ and clear cover not less than } d_0 & \\
\end{align*}
\]

<table>
<thead>
<tr>
<th>Spacing and cover</th>
<th>No. 19 and smaller bars and deformed wires</th>
<th>No. 22 and larger bars</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clear spacing of bars or wires being developed or spliced not less than (d_0), clear cover not less than (d_0), sharts and lures throughout (c_t) not less than the Code minimum</td>
<td>(\Psi_t \cdot \frac{f_{c,w}}{f_{c}} \cdot d_b)</td>
<td>(\Psi_t \cdot \frac{f_{c,w}}{f_{c}} \cdot d_b)</td>
</tr>
<tr>
<td>Clear spacing of bars or wires being developed or spliced not less than (2d_0), and clear cover not less than (d_0)</td>
<td>(\Psi_t \cdot \frac{f_{c,w}}{1.7f_{c}} \cdot d_b)</td>
<td>(\Psi_t \cdot \frac{f_{c,w}}{1.7f_{c}} \cdot d_b)</td>
</tr>
</tbody>
</table>

In the previous table, No of bars refers to the diameter of bar (mm), \(\Psi_t\) takes the value 1.3 when the depth of the concrete below the bars is more than 300 mm (usually the top reinforcement) and takes the value equal to 1 for other cases. Beam Detailer assumes that the bars are not coated by epoxy \(\Psi_{e} = 1\).

**Field 6**, the user must put the path where the files are located and the name of the beam in interest to start the detailing.

![Figure 29. Launching beam detailing application.](image)
After launching the software by pressing on OK button, Beam Detailer gives the user the option to adjust the spans lengths in order to set the correct framework of the beam. Span length is actually the element length in the analytical model, and since sometimes the model doesn't match with the final framework of the beam, Beam Detailer gives the user the option to modify the spans length by enter (N or n) in the command line:
If the user entered (N or n) the program asks the user to enter the spans length one by one in (cm), the user must know the order of the spans. Beam Detailer understands the span length as they are the distance between the supports (center to center) in the case of columns supports and from the face of the wall when the edge support is a shear wall.

If the user doesn’t want to modify the spans length, it is enough to click on ENTER or (y -Y).
After this step Beam Detailer gives the user the option to adjust the beam's framework by modifying the width of the columns:
The same concept of modifying the spans length is used to modify the columns width.

Then the software asks the user to specify any point to start the detailing (it's enough to enter the value 0 in the command line)

Note: Beam Detailer uses the point (0, 0) to start the drawing for any beam, it means the user has to move his drawings a bit every time he wants to draw a new layout, to avoid any overlapping.

3.2.3 Arrangement of steel bars

Beam Detailer uses a specific algorithm to arrange the reinforcement as shown in Figure 34. Basically uses the recommendation of the ACI 318 to place the longitudinal and transverse bars.
Basic top and bottom bars are the basic bars controlled by the maximum ratio that discussed previously. If the basic bars are not enough to cover the entire longitudinal reinforcement, additional reinforcement will be required to recover the lack of reinforcement.

Additional reinforcement follows the next arrangement:

- Additional top reinforcement at each support divided to secondary and main bars. Calculated by taking the maximum top reinforcement at the right and the left of each support (the half station locations from each side).
- Additional bottom reinforcement is divided to two parts:
  - a) Additional bottom reinforcement at the supports: This reinforcement is calculated based on the maximum value of the bottom reinforcement for two station locations at the right and two station locations at the left of the each support.
  - b) Additional bottom reinforcement in the middle of each span: This reinforcement is calculated based on the maximum value of the bottom reinforcement for the middle stations locations (span’s stations locations minus two from each side) for each span along the beam.

Beam Detaller uses the reinforcement envelope diagram to calculate and extend the additional bars (top and bottom) along the length of the beam, by satisfying the extension condition of ACI 318, as shown in Figure 35:
The extension at zero point (where there’s no required reinforcement top or bottom) is always taken as the maximum of:
- 12 time the favorite bar diameter
- Maximum clear span along the length of the beam /16
- Maximum beam height for all the spans

In the case where there’s no inflection point (no zero reinforcement), Beam Detailer uses Class B bars splice (1.3 time the development length $\ell_d$). Assuming the conditions 12.10.5 are satisfied.

Figure 35. Extension rules for longitudinal bars ACI 318.

**Note:** Any other requirements of ACI or any other standard must be satisfied by the user.

Additional top bars at the middle supports are extended to the left and the right of each support. Beam Detailer plots the extension value for each additional bars (main and secondary) as shown in Figure 36.

Figure 36. Extension of the additional top bars.

The additional bottom reinforcement at the supports has also two extension values, right and left measured from the center of the column. Where the additional bottom in the middle of the span has one extension value equal to the distance from the face of the left support to the left edge of these bars as shown in Figure 36.
Figure 37. Extension of the additional bottom bars.

In the case of a shear wall support at the edge of the beam, Beam detailer automatically uses the development length to extend the bars inside the shear wall, as shown in Figure 38.

Figure 38. Case of shear wall edge support.

Reinforcement envelopes diagrams

Figure 39 shows the envelope diagrams:

Figure 39. Envelopes diagrams and station locations.

Beam Detailing draws five diagrams, each is assigned to a different layer using different colors:

- Required bot reinforcement: Is the design bottom reinforcement based on the exported results from ETABS (cm2).
3.2.4 Materials Memory

Beam detailing application provides a short memory in each layout as shown in Figure 40. This memory helps the user to have an idea about the reinforcement amount in the beam. $ldt$ is the development length for the top bars, $lat$ is the bars splice length for the top bars, $ldb$ is the development length for the bottom bars, and $lab$ is the bar splice length for the bottom bars.

The previous lengths were calculated for the corresponded diameters for top and bottom bars based on the concrete strength and the steel yield strength. This memory helps the user to reach the most economic design by performing different detailing for the same beam, since changing the basic reinforcement as well as the favorite bars diameter and the transverse bars diameters can change the weight of the rebar. Beam Detailing gives the ratio of the rebar to volume of concrete for the entire beam.

![Rebar Per Cube Meter of Concrete 261 Kg/m3](Image)

<table>
<thead>
<tr>
<th>Rebar Per Cube Meter of Concrete</th>
<th>261 Kg/m3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total Transverse Reinforcement Weight</td>
<td>673 Kg</td>
</tr>
<tr>
<td>Total Top Bars Weight</td>
<td>442 Kg</td>
</tr>
<tr>
<td>Total Bottom Bars Weight</td>
<td>290 Kg</td>
</tr>
<tr>
<td>Total Longitudinal Bars Weight</td>
<td>787 Kg</td>
</tr>
<tr>
<td>$f_c$</td>
<td>25 MPa</td>
</tr>
<tr>
<td>$F_y$</td>
<td>420 MPa</td>
</tr>
</tbody>
</table>

/ $ldt$ ($\phi_{12}$) = 40 $\phi$ / $lat$ ($\phi_{12}$) = 52 $\phi$ /

/ $ldb$ ($\phi_{12}$) = 40 $\phi$ / $lab$ ($\phi_{12}$) = 52 $\phi$ /

Figure 40. Materials short memory.

3.2.5 Beam Framework and Reinforcing Bar Hook:

The height of the framework in the beam’s layout is always taken as the height of the first span. In the case when the beam has different heights or different widths, Beam Detailing draws different section in order to identify the different section along the length of the beam.

Reinforcing bar hook is always taken as (the height – 5 cm), where the height is the one used to draw the framework. The bars hook can be easily modified by the user.

*We recommend the user to attach some typical details in the beams layouts, in order to satisfy the design codes as well to help the construction engineers to understand the arrangement of the reinforcement.*

3.2.6 Plan Beam Detailing Application:

By writing `CSIBEAM` again in the command line, the user interface will appear again. Select the Plan Beam Detailing application to make it active. Same features of Beam Detailing application are applied in this application, except the adjustment of the beam framework.
By writing the name of the file Plan_Beam_Detailing in the text file name as shown in Figure 41, the software will start to carry out the detailing for all the detected beams in the selected plan, using the same algorithm of Beam Detailing application.
3.3 Tips
This chapter helps the users to handle beam detailing package professionally:

- **Beam detailing package is a tool to simplify the interaction between structural analysis software and the operation of generating the layouts of reinforced concrete beams. Beam Detailing as any other tool still have some limitations, we have done our best to make it simple, flexible and powerful. We really recommend the new users to read this document and understand the basics and the assumptions of Beam Detailing. Produced information and drawings must be reviewed carefully by a qualified engineer or architect.**

- Do not use the edit area to mesh the shear wall element, use the normal mesh option.

- Make sure you have exported the results in (mm) units.

- Beam Detailing understand each intersection joint in the analytical model developed via (ETABS, SAP 2000 or RISA 3D), as a support between two spans. For this reason try to divide the beams element only at the columns or at the shear walls.

- Do not overlap the beam elements with shear elements.

- Do not insert columns elements at the edge of wall element, the connection in this case must be beam to wall.

- Don’t forget to deselect all the nonstructural element from the model before exporting the results, in the same time remain on the joints between elements.

- Export each floor individually

- Remember always to select the upper and the lower nodes of element –in the case of the first floor you have to select the base nodes.

- For SAP 2000 models, don’t forget to deselect all the slab elements before exporting the tables.

- Do not export any unnecessary tables of any model [ETABS or SAP 2000].

- Local axes direction of beam elements must be reviewed by the user, especially for the case of a beam with just one span. In order to identify the end supports.

- Try to avoid switching the local axis (1) of continuous beams. It’s always better to model the beams in the same direction.

- Beam Detailing Generator for ETABS and SAP 2000 assumes the columns and beams section have t3 –t2 dimension. Any section that has no t3- t2 dimension Beam detailing Generator will not be able to run. In this case the user has to fill these values manually in the exported file.